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Paper Set 1 · 31 May 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
Ramesh and Suresh can complete a task in 6 days, while Amit and
Ravi can complete the same task in 18 days. How long will Ramesh,
Suresh, Amit, and Ravi take to complete it together?

A.  4 days

B.  4.5 days

C.  5 days

D.  6.5 days

✓

Q2 Quant
Arrange the following ratios in descending order.

2:5, 5:3, 1:4, 7:8

A.  5:3, 7:8, 2:5, 1:4

B.  5:3, 1:4, 7:8, 2:5,

C.  5:3, 2:5, 1:4, 7:8

D.  7:8, 5:3, 2:5, 1:4

✓

Q3 Quant
A person goes from A to B at 12 km/h and returns via the same
route at 18 km/h. If he had gone both ways at the speed of 15 km/h,
he would have saved 20 minutes. Find the distance between A and
B.

A.  40 km

B.  50 km

C.  60 km

D.  70 km

✓

Q4 Quant
The costs of 10 pens, 15 pencils, 20 notebooks, and 25 erasers are in
proportion.
The cost of one pen is ₹5, the cost of one pencil is ₹6, and the cost of
one notebook is ₹10.
Find the total cost of 10 erasers.

A.  ₹144

B.  ₹140

C.  ₹136

D.  ₹132

✓

Q5 Quant
Find the median of the following set of numbers:

{27, 15, 22, 30, 18, 25, 20}

A.  22

B.  25

C.  20

D.  18

✓

Q6 Quant
A train travels from A to B at 60 km/hr and returns at 40 km/hr. What
is the average speed of the train for the round trip?

A.  45 km/hr

B.  48 km/hr

C.  50 km/hr

D.  55 km/hr

✓

Q7 Quant
A chemist has two acid solutions, one containing 30% acid and the
other containing 50% acid. How much of each solution should be
mixed to obtain 20 litres of a solution containing 40% acid?

A.  1st solution = 10 liters, 2nd solution = 10 liters

B.  1st solution = 12 liters, 2nd solution = 8 liters

C.  1st solution = 8 liters, 2nd solution = 12 liters

D.  1st solution = 15 liters, 2nd solution = 5 liters

✓

Q8 Quant
A class has two sections. Section P has 18 students with an average
score of 74 marks, and Section Q has 27 students with an average
score of 82 marks. What is the weighted average score of all 45
students?

A.  76.4

B.  77.6

C.  78.8

D.  79.2
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✓

Q9 Quant
A trader buys a laptop for ₹40,000, spends ₹2,000 on repairs, and
then sells it to a dealer at a 10% profit on his total cost. The dealer
further sells it to a customer at a 5% loss on his purchase price.
What price does the customer pay?

A.  ₹41,800

B.  ₹46,200

C.  ₹43,890

D.  ₹45,000

✓

Q10 Quant
The price of a fan is first increased by 17% and then the increased
price is decreased by 20%. The resulting price of the fan is ₹2,870.
Find the original price of the fan (rounded nearest to the rupee).

A.  ₹2,980

B.  ₹3,066

C.  ₹3,145

D.  ₹3,270

✓

Q11 Quant
Arvind bought an article for ₹x. He sold it to Biru at a loss of 30%.
Biru spent ₹146 on its transportation and sold it to Minu at a profit
of 60%. If Minu bought it for ₹1,936, then what is the value of x?

A.  1520

B.  1484

C.  1532

D.  1504

✓

Q12 Quant
A sum of ₹4,179 is divided into three parts such that half of the first
part, one-fourth of the second part, and one-eighth of the third part
are equal. What is the positive difference (in ₹) between the first and
the second parts?

A.  597

B.  497

C.  747

D.  697

✓

Q13 Quant
What will be the amount after 1 year, if ₹7,500 is invested at 12%
compound interest per annum, compounded half-yearly?9795

A.  ₹8,427

B.  ₹9,399

C.  ₹8,268

D.  ₹8,643

✓

Q14 Quant
Two secants AB and AP are drawn to a circle from an external point
A. AB intersects the circle at points S and T, and AP intersects the
circle at C and D. AS < AT and AC < AD, AS = 8 cm, ST = (4x + 3) cm, AC

= 12 cm and CD = (2x - 3). What is the length (in cm) of AD?

A.  22

B.  27

C.  14

D.  19

✓

Q15 Quant
A number when increased by 60%, gives 3390. The number is:

A.  2118.75

B.  2237.53

C.  1059.37

D.  1356.25

✓

Q16 Quant
A tap fills a tank in 11 hours. Another tap empties the full tank in 33
hours. How long (in hours) will it take to fill two-third of the tank if
the tank is empty initially and both the taps are open together?

A.  11

B.  15

C.  33

D.  38
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✓

Q17 Quant

A.  0

B.  3

C.  9

D.  1

✓

Q18 Quant
Two circles of radii 6 cm and 3 cm are touching each other externally. Find the length of common tangent.

A.  

B.  

C.  

D.  

✓

Q19 Quant
In a triangle, the angles are in the ratio of 1 : 2 : 1. The corresponding sides are in the ratio:1383

A.  

B.  

C.  

D.  

✓

Q20 Quant
The value of 2.8888... + 1.3636... - 1.5555... is:

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
Which of the following statements about a magnetic field is correct?

A.  The magnetic field is a scalar quantity.

B.  Magnetic field lines emerge from the south pole and merge
at the north pole outside a magnet.

C.  The magnetic field strength is stronger where the field lines
are closer.

D.  Magnetic field lines can cross each other at certain points.

✓

Q22 GA
Who among the following athletes set a new national decathlon
record for India by scoring 7,826 points at the Wieslaw Czapiewski
Memorial athletics meet held in Poland in July 2025?

A.  Neeraj Chopra

B.  Tejaswin Shankar

C.  Avinash Sable

D.  Murali Sreeshankar

✓

Q23 GA
The famous 'Grand Canyon' is located in which country?

A.  USA

B.  India

C.  Russia

D.  China

✓

Q24 GA
The Dandi March (1930) was a part of which of the following major
movements?

A.  The Non-Cooperation Movement

B.  The Quit India Movement

C.  The Civil Disobedience Movement

D.  The Ghadar Movement

✓

Q25 GA
According to Odisha Economic Survey 2024-25, what was the
industry sector’s contribution to Odisha’s economy?

A.  40%

B.  42%

C.  44%

D.  46%

✓

Q26 GA
The law that abolished intermediary (zamindari) estates in Odisha
soon after Independence was:

A.  Odisha Tenancy Reform Act, 1950

B.  Orissa Estates Abolition Act, 1951

C.  Odisha Land Reforms Act, 1960

D.  Orissa Agrarian Reforms Act, 1952

✓

Q27 GA
Why does soap solution appear cloudy?

A.  Because soap dissolves completely in water

B.  Because soap micelles are large enough to scatter light

C.  Because soap reacts with water to form gas bubbles

D.  Because soap contains colored impurities

✓

Q28 GA
What was the theme of the Association of Southeast Asian Nations
(ASEAN) Summit held in October 2025?

A.  Innovation & Growth

B.  Maritime Connectivity First

C.  Digital & Green Transition

D.  Inclusivity and Sustainability

✓

Q29 GA
What is the primary objective of the Chief Minister Adibandh
Scheme 3.0 in Odisha launched in December 2025?

A.  To modernize rural housing

B.  Enhancing irrigation infrastructure

C.  Promoting industrialization

D.  To improve transportation networks

✓

Q30 GA
Odisha launched the Atmanirbhar Mahila Su Vahak programme
to:

A.  Provide free e-rickshaws to SHGs

B.  Empower women as transport entrepreneurs.

C.  Offer driving lessons for adolescent girls only

D.  Employ women in government fleet management
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Q31 GA
In the World Justice Project (WJP) Rule of Law Index 2025, released in
October 2025, what rank did India secure among 143 countries?

A.  72

B.  86

C.  94

D.  102

✓

Q32 GA
Which among the following cities will host the Commonwealth
Games 2030?

A.  Ahemedabad

B.  Delhi

C.  Bengaluru

D.  Sikkim

✓

Q33 GA
During which Five-Year Plan was the “Minimum Needs Programme”
introduced to improve access to basic services such as health,
education, and drinking water, particularly in underserved areas?

A.  The Fifth Five-Year Plan

B.  The Second Five-Year Plan

C.  The Third Five-Year Plan

D.  The Seventh Five-Year Plan

✓

Q34 GA
A scientist observes a cell with a large central vacuole, tonoplast,
and cell sap. Which type of organism is this cell most likely from?

A.  Bacteria

B.  Protist

C.  Plant

D.  Animal

✓

Q35 GA
Śharad season in the traditional Indian calendar corresponds most
closely to which of the following?

A.  Spring

B.  Rainy season

C.  Autumn

D.  Winter

✓

Q36 GA
Which coastal landforms are most commonly produced when the
sea moves inland due to dominant erosion, particularly where rock
type and weak zones are present?

A.  Cliffs

B.  Dunes

C.  Bars

D.  Beaches

✓

Q37 GA
The Directive Principles of State Policy in the Constitution of India
are inspired by the Constitution of which of the following countries?

A.  The United States of America

B.  The United Kingdom

C.  Ireland

D.  Canada

✓

Q38 GA
The Qutb Minar and its Monuments complex is owned by the
Government of India and managed by which of the following
institutions/organisations?

A.  Archaeological Survey of India

B.  NITI Aayog

C.  Centre for Cultural Resources and Training

D.  Anthropological Survey of India

✓

Q39 GA
Which of the following best explains the nature of Lavani?

A.  Devotional and slow-paced music only

B.  Rhythmic folk performance of Maharashtra

C.  Court-based Persian music

D.  Pure instrumental classical form

✓

Q40 GA
Which of the following pollutants is primarily responsible for
causing global warming by trapping heat in the Earth’s atmosphere?

A.  Oxygen

B.  Nitrogen

C.  Carbon dioxide

D.  Helium
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English

✓

Q41 English
Select the most appropriate option to fill in the blanks. If no article is required, select the option with ‘No article required’.

______ Himalayas are known for ______ highest peaks in the world.

A.  No article required; the

B.  The; a

C.  The; the

D.  A; the

✓

Q42 English
Select the most appropriate option to fill in the blank.

The scientist’s discovery was met with suspicion due to the lack of proper evidence, branding it a scientific _____________.

A.  breakthrough

B.  hypothesis

C.  fraud

D.  theory

✓

Q43 English
Substitute the underlined word segment in the given sentence with the most appropriate idiom.

He was working late into the night to finish his project before the deadline.

A.  burning the midnight oil

B.  barking up the wrong tree

C.  beating around the bush

D.  crying over spilt milk

✓

Q44 English
Select the most appropriate verb to fill in the blank.

The thief __________ by the time the police reached the spot.

A.  escaped

B.  had escaped

C.  was escaping

D.  has escaped

✓

Q45 English
Select the idiom that best replaces the highlighted words in the given sentence.
Every day after dinner, he spent time thinking deeply over his uncertain future plans.

A.  chewed the fat

B.  bit the bullet

C.  chewed the cud

D.  bit off more than he could chew
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✓

Q46 English
Identify the correct antonym of the underlined word in the sentence given below.
The heavy rain ravaged the village crops, and left the farmers in great distress.

A.  ruined

B.  dried

C.  preserved

D.  harvested

✓

Q47 English
Identify the option that is the correct antonym of the underlined word in the sentence.
The euphoria of purchasing a dream house was beyond words, filling the family with immense joy and satisfaction.

A.  elation

B.  despair

C.  expense

D.  reality

✓

Q48 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

but you convince yourself that the sunshine on the other side (A) / in the face while you're in the eye of it (B) / maybe you don't feel like dancing
in the rain (C) / of the hurricane is worth gritting your teeth and letting the hail pelt you (D)

A.  D, A, B, C

B.  C, A, D, B

C.  B, D, A, C

D.  D, B, A, C

✓

Q49 English
Select the correct indirect speech form of the following sentence.

They said, “We have completed the project.”

A.  They said that they had completed the project.

B.  They said that they have completed the project.

C.  They said that that we have completed the project.

D.  They said that that the project is completed.

✓

Q50 English
Select the option that expresses the given sentence in passive voice.

Bimal was painting the house.

A.  The house was painted by Bimal.

B.  The house was being painted by Bimal.

C.  The house is painted by Bimal.

D.  The house has been painted by Bimal.
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✓

Q51 English
Select the most appropriate option to complete the given sentence.
She is good ___ mathematics.

A.  for

B.  on

C.  with

D.  at

✓

Q52 English

Read the given passage carefully and answer the questions that follow by choosing the most appropriate option.

Scientific research plays a fundamental role in expanding human knowledge and addressing complex global challenges. Through systematic
investigation and experimentation, researchers develop new theories, technologies, and solutions that improve various aspects of life. Advances
in medicine, environmental science, and engineering often emerge from sustained research efforts carried out in universities and research
institutions. However, scientific research also requires rigorous standards of accuracy, transparency, and ethical responsibility. Researchers must
ensure that their findings are based on reliable evidence and that their methods can be verified by others. Academic integrity is particularly
important because inaccurate or misleading research can have serious consequences for society. For example, flawed medical studies may lead
to ineffective treatments or incorrect policy decisions. For these reasons, the scientific community emphasizes peer review, careful
documentation, and open discussion of research findings. Such practices help maintain the credibility of scientific knowledge and ensure that
research continues to contribute positively to human progress.

Identify the suitable title for the passage from the following options.

A.  The Significance of Ethical and Dependable Scientific Research

B.  The Historical Development of Scientific Laboratories

C.  The Evolution of Engineering Education

D.  The Impact of Technology on the Entertainment Industry

✓

Q53 English
Identify the central theme of the passage.

A.  Scientific research often replaces traditional knowledge in many modern academic contexts.

B.  Engineering research is often considered more important than medical research in certain contexts.

C.  Universities primarily conduct research for academic purposes within structured institutional frameworks.

D.  Scientific research is important but must follow ethical and reliable standards.

✓

Q54 English
Identify the fact given in the passage.

A.  Scientific research does not influence policy decisions.

B.  Peer review helps maintain the credibility of research findings.

C.  Universities rarely participate in scientific research.

D.  Medical research has no effect on public health policies.

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q55 English
Select the correct summary for the passage.

A.  Scientific research advances knowledge but requires ethical standards and reliable verification processes.

B.  Scientific discoveries are often accidental and do not always follow systematic investigative procedures.

C.  Research institutions mainly focus on engineering and technological development across various modern fields.

D.  Scientific research has limited influence on contemporary social and economic development worldwide.

✓

Q56 English
Choose the antonym of the word “rigorous” as used in the passage.

A.  Systematic

B.  Thorough

C.  Careless

D.  Strict

✓

Q57 English
Choose the correct option to complete the sentence.

If you call her now, she ______ you with the details of the case filed.

A.  helps

B.  will help

C.  helped

D.  has helped

✓

Q58 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

(P) that using familiar units of distance
(Q) chosen for their utility on Earth
(R) the dimensions of the cosmos are so large
(S) such as metres or miles
(T) would make little sense

A.  RPSQT

B.  RSQPT

C.  PRTSQ

D.  QSRTP
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✓

Q59 English
Select the option that can be used as a one-word substitute for the given group of words.

A statement that appears self-contradictory but may contain truth

A.  Paradox

B.  Irony

C.  Allegory

D.  Hyperbole

✓

Q60 English
Rectify the sentence by selecting the correct spelling from the options
Culture (1) in any place always goes top down, never bottom up. We need to step back and look at what kind of environment we have created
for ourselves and those around us. It is (2) tough to expect positive behaviour in a negative environment. Where (3) lawlessness becomes the
law, honest citizens become cheats, (4) croks and thieves.

A.  Cultur

B.  Crooks

C.  Theives

D.  Lawlesness

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
"ଭାରତର ସମ୍ବି ଧାନ 1950 ମସି ହା ଜାନୁ ଆରୀ 26ରୁ  ଲାଗୁ  ହେଇଥି ଲା ।"

A.  The Constitution of India came into effect on 26th January 1950.

B.  The Constitution of India was written in 1947.

C.  The Constitution was enacted in 1971.

D.  The Constitution was signed by the British Parliament.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ନାଳନ୍ଦା ବି ଶ୍ୱବି ଦ୍ୟାଳୟ ବି ଶ୍ୱର ଏକ ପୁ ରାତନ ଶି କ୍ଷଣ କେନ୍ଦ୍ର ଅଟେ ।

A.  Nalanda University was an ancient center of learning in the world.

B.  Nalanda University were ancient learning centre world.

C.  Nalanda University is the old learning of world.

D.  The Nalanda University was oldest university of worlds.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଜଗନ୍ନାଥ ମନ୍ଦି ର ପୁ ରୀ ସହରରେ ଅବସ୍ଥି ତ ଅଟେ ଯାହାକି  ଓଡ଼ି ଶାର ଏକ ବି ଖ୍ୟାତ ସ୍ଥଳଚି଼ ହ୍ନଗୁ ଡି କ ମଧ୍ୟରୁ  ଅନ୍ୟତମ ।

A.  The Jagannath Temple is situated in Puri city, one of Odisha’s famous landmarks.

B.  The Jagannath Temple situated in Puri city, one of Odisha famous landmarks.

C.  The Jagannath Temple is situate in Puri city, one of Odisha’s famous landmarks.

D.  The Jagannath Temple are situated in Puri city, one of Odisha’s famous landmarks.
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✓

Q64 Odia
ସଠି କ ତଦ୍ଭବ ଶବ୍ଦ ବାଛନ୍ତୁ: “କପାଳ” ର ତଦ୍ଭବ କଣ?

A.  କପାଲ

B.  କପୋଳ

C.  କପାଉ

D.  କାପା

✓

Q65 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  "ଅର୍ଦ୍ଧ ଚନ୍ଦ୍ର ଦେବା "-ରୂ ଢି ର ଅର୍ଥ  କଣ ?

A.  ଅଧା ଚନ୍ଦ୍ର ଦେବା

B.  ଆମନ୍ତ୍ରଣ କରି ବା

C.  ଦୋଷ ଦେବା

D.  ତଣ୍ଟି ଆ ଦେବା

✓

Q66 Odia
ନଳି ନୀ ଗୀତଟି  ଚମତ୍କାର ଗାଇଲା। ଏହି  ବାକ୍ୟରେ ଥି ବା କ୍ରି  ୟାବି ଶେଷଣ ପଦଟି କୁ  ଚି ହ୍ନଟ କର।

A.  ଚମତ୍କାର

B.  ଗୀତଟି

C.  ନଳି ନୀ

D.  ଗାଇଲା

✓

Q67 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଛେଦକୁ  ପାଠ କରି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ବାଛ ।
ମଣି ଷର ଆଚରଣରୁ  ତାର ବ୍ୟକ୍ତି ତ୍ଵର ପରି ପ୍ର କାଶ ଘଟି ଥାଏ । ତା' ଜୀବନର ଜୟଯାତ୍ରା  ତା'ର ଯାବତୀୟ କାର୍ଯ୍ୟ କଳାପ ଦ୍ଵାରା ନି ୟନ୍ତ୍ରି ତ ହୋଇଥାଏ । ଯେ ଯେଉଁ ପରି  କାର୍ଯ୍ୟ କରେ ସେ ତଦନୁ ସାରେ
ଫଳପ୍ରା ପ୍ତ ହୋଇଥାଏ । ସତକର୍ମ  ସର୍ବ ଦା ସୁ ଫଳ ଏବଂ ଅସତ କର୍ମ  ସର୍ବ ଦା ମନ୍ଦ ଫଳରେ ପର୍ଯ୍ୟ ବସି ତ ହୋଇଥାଏ । ଭାଗବତରେ ଅଛି -"ଯେଣେ ଇଛା ତେଣେ ଯାଅ,କର୍ମ  ଘେନି  ବୁ ଲୁ ଥାଆ" , କର୍ମ କୁ
ଆଧାରକରି  ନାନା ପ୍ର ବଚନ ଓଡି ଆ ସାମାଜି କ ଚଳଣି ରେ ପ୍ର ଚଳି ତ । ଇଂରାଜୀ ଭାଷାରେ ଏଥି ପାଇଁ  କୁ ହାଯାଇଛି -'As you sow, so you reap' ଅର୍ଥ  ଜଣେ ଚାଷୀ ତା'ର ଚାଷ ଜମି ରେ ଯେମି ତି  ମଞ୍ଜି
ବୁ ଣି ବ ଓ ବେଉଷଣ କରି ବ, ସେ ସେହି  ଅନୁ ଯାୟୀ ଫଳ ଫଳାଇବ ବା ଅମଳ କରି ବ । କର୍ମ  ହିଁ ମାନବର ମାନଦଣ୍ଡକୁ  ନି ର୍ଣ୍ଣିତ କରାଇଥାଏ । ଜଣେ ପାଠଶାଠ ପଢି  ଚାକି ରୀ କରି  କେବଳ ତା'ର
ପରି ବାର ପ୍ର ତି ପୋଷଣ କରି ପାରି ଥାଏ । ଜଣେ ତା'ର ଶି କ୍ଷା ସହି ତ ଯଦି  ଲେଖା ଲେଖି  କରି  ସମାଜକୁ  କୁ ସଂସ୍କାରକୁ  ଦୂ ର କରି ବାରେ ସଫଳ କାମ ହୁ ଏ ତେବେ ତା'ର ବି ଭି ନ୍ନ ପରି ଚୟ ସୃ ଷ୍ଟି  ହୁ ଏ । ତା'ର
ଏହି  କର୍ମ  ତାକୁ  ଚି ରଦି ନ ପାଇଁ  ବଞ୍ଚାଇ ରଖେ । କର୍ମ କୁ  ଠି କମାର୍ଗ ରେ ପରି ଚାଳନା ନ କଲେ ଜୀବନ ବି ଷମୟ ହୋଇଉଠେ । ସେଥି ପାଇଁ , ଯେମି ତି  କାମ କରି ବ,ସେହି  ଅନୁ ଯାୟୀ ଫଳ ପାଇବ ।

ଅନୁ ଚ୍ଛେଦର ସଠି କ ସାରାଂଶ କେଉଁ ଟି  ?

A.  ଶି କ୍ଷା ମାନବ ଜୀବନର ସର୍ବ ପ୍ର ଧାନ ଅଂଶ ।

B.  ଧନ-ସମ୍ପତ୍ତି  ମାନବକୁ  ମହାନ କରେ ।

C.  କର୍ମ  ମାନବର ବ୍ୟକ୍ତି ତ୍ଵ ଓ ଭାଗ୍ୟ ନି ର୍ଣ୍ଣ ୟ କରେ ।

D.  ସହର ଜୀବନ ଗ୍ରା ମ୍ୟ ଜୀବନଠାରୁ  ଭଲ ।

✓

Q68 Odia
"As you sow, so you reap" ର ଅର୍ଥ  କଣ ?

A.  ଶି କ୍ଷା ଦ୍ଵାରା ମାନବ ସଫଳ ହୁ ଏ ।

B.  ଯେମି ତି  କର୍ମ  କରି ବ ସେମି ତି  ଫଳ ପାଇବ ।

C.  ଧନୀ ଲୋକ ସବୁ ବେଳେ ସଫଳ ।

D.  ଭାଗ୍ୟ ସବୁ କି ଛି  ନି ର୍ଣ୍ଣ ୟ କରେ ।
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✓

Q69 Odia
'ଭାଗବତ' ଅନୁ ସାରେ ମଣି ଷ କାହାକୁ  ସାଥି ରେ ଘେନି  ବୁ ଲୁ ଥାଏ ?

A.  ପରି ବାରକୁ

B.  ଟଙ୍କା ପଇସାକୁ

C.  ଶି କ୍ଷାକୁ

D.  କର୍ମ କୁ

✓

Q70 Odia
ଜଣେ ବ୍ୟକ୍ତି କୁ  କ'ଣ ଚି ରଦି ନ ପାଇଁ  ବଞ୍ଚାଇ କରି  ରଖେ ?

A.  ତା'ର ଚାକି ରୀ

B.  ତା'ର ପାଠଶାଠ

C.  ତା'ର ଉତ୍ତମ କର୍ମ  ଓ ସମାଜ ସଂସ୍କାର

D.  ତା'ର ପରି ବାର ପ୍ର ତି ପୋଷଣ

✓

Q71 Odia
ଅନୁ ଚ୍ଛେଦ ଅନୁ ଯାୟୀ ମାନବର ମାନଦଣ୍ଡ କାହାଦ୍ଵାରା ନି ର୍ଣ୍ଣ ୟ ହୁ ଏ ?

A.  କର୍ମ

B.  ଜାତି

C.  ବୟସ

D.  ସ୍ଥାନ

✓

Q72 Odia
ଶୁ ଦ୍ଧ ବାକ୍ୟଟି  ଚୟନ କର ।

A.  ଉତ୍କଳ ଦୀବସ ଆମ ବି ଦ୍ୟାଳୟ ଆନୂ କୁ ଲ୍ୟରେ ପାଳି ତ ହୋଇଯାଇଛି  ।

B.  ଉତ୍କଳ ଦୀବସ ଆମ ବୀଦ୍ୟାଳୟ ଆନୂ କୂ ଲ୍ୟରେ ପାଳି ତ ହୋଇଯାଇଛି  ।

C.  ଉତ୍କଳ ଦି ବସ ଆମ ବୀଦ୍ୟାଳୟ ଆନୂ କୂ ଲ୍ୟରେ ପାଳି ତ ହୋଇଯାଇଛି  ।

D.  ଉତ୍କଳ ଦି ବସ ଆମ ବି ଦ୍ୟାଳୟ ଆନୁ କୂ ଲ୍ୟରେ ପାଳି ତ ହୋଇଯାଇଛି  ।

✓

Q73 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  'ନି ଷେଧାର୍ଥ କ ଅବ୍ୟୟ' ଅଟେ ?

A.  ନା

B.  ଏବଂ

C.  କାହିଁକି

D.  ଯେହେତୁ
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✓

Q74 Odia
"ଢୋକେ ପି ' ଦଣ୍ଡେ ଜି  "- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କ'ଣ ?

A.  ଢୋକେ ପାଣି  ପି ଇ ବଞ୍ଚି ରହି ବା

B.  ଆରମରେ ଜୀବନ ଯାପନ କରି ବା

C.  ଅଳ୍ପ ପାଣି  ପି ଇ ବଞ୍ଚି ରହବା

D.  କଷ୍ଟେମଷ୍ଟେ ବଞ୍ଚି ରହି ବା

✓

Q75 Odia
ଯଦି  ମୁଁ  ପୁ ରୀଯାଏ, ତେବେ ମହାପ୍ର ସାଦ ଆଣି ବି  ।- ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  ପ୍ର କାର ଅବ୍ୟୟ?

A.  ସମ୍ଭାବନାସୂ ଚକ ଅବ୍ୟୟ

B.  ସମ୍ବୋଧନସୂ ଚକ ଅବ୍ୟୟ

C.  ପ୍ର ଶ୍ନ ସୂ ଚକ ଅବ୍ୟୟ

D.  ସମ୍ମତି ସୂ ଚକ ଅବ୍ୟୟ

Computer

✓

Q76 Computer
Which action in MS Word 2021 allows checking document layout and
margins before printing?

A.  Save As

B.  Print Preview

C.  Mail Merge

D.  Page Setup

✓

Q77 Computer
What is the default setting for slide transitions in a new PowerPoint
presentation?

A.  By mouse click manually

B.  With hyperlink click

C.  Only by timer

D.  Automatically with sound

✓

Q78 Computer
Choose the device needed to connect to the internet through a
telephone line.

A.  Router

B.  Modem

C.  Switch

D.  Hub

✓

Q79 Computer
What is the typical range of a Local Area Network (LAN)?

A.  Within a small geographical area such as a building or
campus

B.  Across multiple cities

C.  Across countries and continents

D.  Between mobile devices only ​​​​​​

✓

Q80 Computer
A CPU can be placed on one or more microchips. What is the
another name for microchips?

A.  Integrated Circuits

B.  Registers

C.  Condute

D.  Transmitters

✓

Q81 Computer
In electronics, the abbreviation PCB refers to which of the following?

A.  Primary Computer Board

B.  Peripheral Circuit Base

C.  Printed Circuit Board

D.  Program Control Block
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✓

Q82 Computer
A local authority uses computer systems to manage citizen records
like birth certificates, property details, and taxes. This application of
computers is best categorized under:

A.  Entertainment and Arts

B.  Business and Commerce

C.  Industrial Automation

D.  Government and Public Service

✓

Q83 Computer
What is the output of the formula =IF(A1>10, "Yes", "No") if
cell A1 contains the value 15?

A.  Yes

B.  No

C.  Error

D.  15

✓

Q84 Computer

How do you undo the last action in MS
Word?

A.  Press Ctrl + Z

B.  Press Ctrl + Y

C.  Press Ctrl + U

D.  Press Ctrl + S

✓

Q85 Computer
Which MS Excel option helps you quickly locate and open recently
used spreadsheets?

A.  File → Open → Recent

B.  Data → Get External Data → From Recent Files

C.  Insert → Recent Files

D.  View → Open Recent

✓

Q86 Computer
What is the primary purpose of the 'Slide Master' in MS PowerPoint?

A.  To create and apply consistent formatting to all slides

B.  To duplicate slides automatically

C.  To enable animations on specific slides

D.  To insert new slides with different templates

✓

Q87 Computer
What happens when you press 'Ctrl + P' in most operating systems?

A.  Closes the Present window

B.  Opens the File menu

C.  Opens the Print dialog box

D.  Saves the Previous document

✓

Q88 Computer
What does the NOW() function return in Excel?

A.  Only the current date

B.  Only the current time

C.  The serial number of the current date and time

D.  The name of the current worksheet

✓

Q89 Computer
Which of the following best describes the main difference between
system software and application software?

A.  System software controls hardware; application software
helps perform tasks.

B.  Application software runs the OS; system software creates
documents.

C.  System software is used only for games; application software
runs the system.

D.  Application software handles booting; system software
opens web pages.

✓

Q90 Computer
While working on a school project in PowerPoint, Priya wants to
ensure her work isn’t lost due to a sudden shutdown. What should
she do regularly to make sure the changes are retained?

A.  Press Ctrl + P to print the slides.

B.  Click on ‘Design’ to change the layout.

C.  Use the ‘Save’ option under the File tab or press Ctrl + S.

D.  Close PowerPoint and reopen it later.
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Reasoning

✓

Q91 Reasoning
In a certain code language,
A + B means ‘A is the wife of B’,
A – B means ‘A is the brother of B’,
A × B means ‘A is the mother of B’,
and A = B means ‘A is the father of B’.

How is P related to Q if ‘P – R + Y = S × Q’?1953

A.  Mother's sister's brother

B.  Father

C.  Mother's mother's brother

D.  Wife's mother's father

✓

Q92 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?
NID61 , HCX66 , BWR71 , VQL76 , ?

A.  PKF81

B.  PHF81

C.  PKB81

D.  PKE81

✓

Q93 Reasoning
Select the triad which follows the same pattern as that followed by
the two triads given below. Both triads follow the same pattern.

OG-QJ-TV
RJ-TM-WY

A.  KC-MF-PR

B.  KC-MF-PS

C.  LC-MF-PS

D.  LC-ME-PS

✓

Q94 Reasoning
What will come in the place of ‘?’ in the following equation, if ‘+’ and
‘-‘ are interchanged and ‘x’ and ‘÷’ are interchanged?
28 ÷ 4 + 64 x 8 - 15 = ?

A.  103

B.  112

C.  115

D.  119

✓

Q95 Reasoning
Each of B, C, D, E, G, H and I has a flight on a different day of the
week starting from Monday and ending on Sunday of the same
week. Only one person has flight between C and E. B doesn't have
flight on Friday. Only three people have a flight between H and D. D
has a flight on the last day of the week. G has a flight immediately
the day before I. How many people have a flight after B?

A.  Five

B.  Six

C.  Four

D.  Three

✓

Q96 Reasoning
Seven people, X, Y, Z, C, D, E and F, are sitting around a circular table
facing the centre of the table. Only one person sits between Z and E
when counted from the left of E. F sits third to the right of D. Y sits
third to the left of X. F sits to the immediate right of Y. C is not an
immediate neighbour of Y. How many people sit between C and E
when counted from the right of C?

A.  Four

B.  Three

C.  Two

D.  One

✓

Q97 Reasoning
In a certain code language, 'MATHS' is coded as '64' and 'ENGLISH' is
coded as '105'.
What is the code for 'SCIENCE' in the given code language?

A.  121

B.  131

C.  118

D.  126

✓

Q98 Reasoning
Based on the alphabetical order, three of the following four are alike
in a certain way and thus form a group. Which is the one that does
not belong to that group?
(Note: The odd one out is not based on the number of
consonants/vowels or their position in the letter cluster.)11725

A.  DBE

B.  AXB

C.  SPT

D.  HEI
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✓

Q99 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.
Statements: Some Venuses are Serenas. No Serenas are Rafaels.
Conclusion I: Some Venuses are Rafaels.
Conclusion II: No Rafaels are Venuses.14524

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow

✓

Q100 Reasoning
Refer to the following series and answer the question. Counting to
be done from left to right.

(Left) S A I A R B N A O D L P I I K U M A R R E K H A V A H I D A R E
(Right)

How many such consonants are there each of which is immediately
preceded by a consonant and also immediately followed by a vowel?

A.  FOUR

B.  THREE

C.  FIVE

D.  TWO
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